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1. INTRODUCTION
Thank you for choosing the ZL6 data logger from METER Group. The ZL6 loggers are part of the 
ZENTRA System: a collection of data loggers, software, and compatible sensors to measure 
environmental parameters accurately and cost effectively. Please refer to metergroup.com/
logger-compatibility for a list of supported sensors.

This manual covers the ZL6 Basic, the ZL6, and the ZL6 Pro. Throughout this manual, all three 
loggers will be referred to as ZL6 unless otherwise noted. The primary differences between 
the loggers are in Table 1.

Table 1 Logger feature differences

Feature ZL6 Basic ZL6 ZL6 Pro

Long-range telemetry hardware for 
automatic uploads to ZENTRA Cloud

None 3G or 4G cellular 3G or 4G cellular

Hourly data uploads None Included Included

Real-time data uploads (15 min) None Sold separately Included

GPS for position and timekeeping None Included Included

Battery technology Alkaline NiMH or alkaline NiMH or alkaline

Battery charging None
Integrated solar 

panel
Integrated solar 

panel

Measurement interval 60 min 5 min to 12 h 5 min to 12 h

Flash data storage 2 MB 8 MB 8 MB

Reference barometer Sold separately Included Included

Sensor cable strain relief Sold separately Included Included

ZENTRA Cloud subscription Sold separately Sold separately 3 years

Warranty 1 year 1 year 3 years

Verify all instrument components are included and appear in good condition:

• ZL6 series logger

• Device ZENTRA Cloud subscription sticker (inside the logger)

• Six batteries

 � Alkaline for ZL6 Basic

 � NiMH rechargeable for ZL6 and ZL6 Pro

• Micro-USB communications cable

• UV-stable plastic zip ties

• Spare parts kit (ZL6 Pro only)

http://metergroup.com/logger-compatibility
http://metergroup.com/logger-compatibility
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2. OPERATION
This section explains the basic workflow of logger installation, logger configuration, and data 
download. Please read all instructions before operating the ZL6 to ensure it performs to its 
full potential. Consider testing the ZL6 and sensors in a lab or office prior to field installation 
to verify the correct operation of the system.

The ZL6 can serve as a data collection station for as many as six sensors. It is designed for 
plug-and-play setup with all METER sensors, including the ATMOS weather sensors, TEROS 
soil moisture sensors, HYDROS water sensors, PHYTOS leaf sensors, and ECH2O soil moisture 
sensors. Please refer to the individual sensor manuals for sensor installation instructions.

NOTE: To use TEROS 31 and TEROS 32 sensors with the ZL6 Basic, a reference barometer sensor must be added to the 
logger. Contact Customer Support.

2.1 INSTALLATION
Follow the steps listed in Table 2 to set up the ZL6 and start collecting data.

NOTE: Never immerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, or improper 
installation may damage the ZL6 and void the warranty.

Table 2 Installation

Tools Needed

Microsoft® Windows® or Apple® Mac® computer for ZENTRA Utility

Apple® iPhone® (iOS 9.0 or newer) or Google AndroidTM smartphone 
(Android 4.3 or newer) for ZENTRA Utility Mobile

Mounting post (or similar)

Preparation

Install ZENTRA Utility or ZENTRA Utility Mobile
To install ZENTRA Utility Mobile on a smartphone or tablet:
• Open the app store.
• Search for ZENTRA Utility Mobile.
• Download the application. 

To install ZENTRA Utility on a computer:
• Navigate to the ZL6 webpage (metergroup.com/zl6-support).
• Click the appropriate ZENTRA Utility Installer link.
• Click through the ZENTRA Utility Installer wizard.

The installer automatically installs the necessary USB driver for the ZL6.

Install Batteries
Press the TEST button. The status lights will eventually settle to a green short, 
single blink every 5 s, signaling it is ready for use.

http://www.metergroup.com/zl6-support


3

ZL6

Table 1 Installation (continued)

Configuration

Configure the ZL6 Using ZENTRA Utility Mobile
On the ZL6, push the TEST button to ensure the Bluetooth® module is 
activated.

On the mobile device, open ZENTRA Utility Mobile.

Select the ZL6 to connect.

Select Configure and set the desired cellular data upload settings (for ZL6 and 
ZL6 Pro) and sensor measurement interval (Section 2.3.2).

NOTE: Configuration using ZENTRA Utility is addressed in Section 2.2.1.

Field Installation

Select Location
Choose the desired location based on relevant details including: representative 
field position for sensor installation, vegetation cover throughout the season, 
distance from power lines, minimal livestock interference, etc.

For ZL6 and ZL6 Pro, orient the solar panel to give it the maximum amount of 
sunlight. In the northern hemisphere this will typically mean the data logger will 
face south; in the southern hemisphere this will typically mean the data logger 
will face north.

NOTE: If the location is in an area where solar energy harvesting is minimal, alkaline 
batteries will power the logger longer than the NiMH batteries when not being recharged 
by the solar panel. The ZL6 does not charge alkaline batteries.

Check Cellular Communication Quality
Evaluate how surroundings may attenuate the cellular signal. Large metallic 
objects, power lines, and plant canopies may block cellular signals. 

Use ZENTRA Utility to check the quality of the cellular signal (Section 2.2.2).

If the signal is low or the cellular test fails, move to an alternative location 
(sometimes moving only a few meters is sufficient).

Fasten Logger to Mounting Post
Use the loopholes on the back of the logger enclosure to mount the ZL6 to a 
post using zip ties or a similar fastener (such as hose clamps).

Ensure the logger is installed in an upright position to reduce the possibility of 
water entering the ZL6 enclosure.

NOTE: The ZL6 case is water resistant, not waterproof. In extremely wet environments or 
environments with prolonged high humidity, place a desiccant packet inside the logger or 
enclose the logger in a waterproof case. 
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Table 1 Installation (continued)

Field Installation 
(continued)

Install Sensors
Install each sensor as directed in the sensor user manual.

Thread cables near the ground through conduit or plastic cladding to avoid 
damage.

Plug the sensor stereo plug connectors firmly into the ZL6 input ports.

Put each cable in the corresponding strain relief hook and use thumb screws to 
tighten the strain relief hook.

Perform instantaneous scan to ensure sensors are working properly 
(Section 2.2.3).

2.2 INTERFACING WITH ZL6 USING A COMPUTER
Download ZENTRA Utility from the ZL6 webpage (metergroup.com/zl6-support) before going 
to the field. Add ZENTRA Cloud user credentials to allow uploading data.

2.2.1 CONFIGURATION
The measurement interval and sensor types must be set before data will be correctly 
stored by the logger.

To configure the ZL6 in ZENTRA Utility, refer to the following steps:

1. Plug the micro-USB cable into the logger USB port and the computer USB port.

2. Open the ZENTRA Utility application (Figure 1).

Figure 1 ZENTRA Utility initial screen with ZL6 in COM port dropdown

http://www.metergroup.com/zl6-support
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On the ZENTRA Utility main screen, the connected ZL6 should appear in the dropdown 
menu. If the logger designation does not appear in the dropdown, try a different port 
or cable.

3. Click the Connect button next to the COM port dropdown menu (Figure 2).

Once successfully connected, ZENTRA Utility displays the instantaneous sensor 
measurements from the ZL6 (Figure 2).

Figure 2 ZENTRA Utility showing a connected ZL6 and its instantaneous measurements

4. Click Settings in the Button toolbar.

The Manage Settings dialog will appear.

5. Navigate to the Device Information tab (Figure 3).
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Figure 3 Device Information tab

6. Enter a device name.

This value is prepopulated with the device serial number. Consider changing the name to 
the field or plot where the ZL6 is installed. 

7. Navigate to the Sensor Configuration tab (Figure 4).

Figure 4 Sensor Configuration tab
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8. Adjust the Measurement Interval to the desired time for storing sensor measurements.

The ZL6 Basic has a fixed measurement interval of 60 min. Section 3.2.2 provides more 
information on how the ZL6 makes measurements.

9. Confirm all sensors are plugged into the ZL6.

10. Ensure the correct sensor type is listed in each port tab (Figure 5).

If the sensor is not automatically recognized, pick the correct sensor setting from the 
Sensor Type dropdown menu.

NOTE: Check the cellular signal (Section 2.2.2) for ZL6 and ZL6 Pro loggers at the expected installation location 
before installing sensors.

Figure 5 Select Sensor Type dropdown

ZL6 Basic logger configuration is complete at this point. ZL6 and ZL6 Pro logger 
configuration will need to continue to step 11 through step 13 to set up the desired data 
upload times.

11. Navigate to the Communication Settings tab (Figure 6).
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Figure 6 Communication Settings tab

12. Select the time segments in Upload Times by clicking the arc segments for the hour 
intervals.

The ZL6 will upload data during the selected intervals (Section 4.2.5.1).

13. Click OK.

2.2.2 COMMUNICATION TEST (ZL6 AND ZL6 PRO)
A successful communication test will confirm that the ZL6 can transmit data to ZENTRA 
Cloud servers as well as provide the quality of the cellular connection. Even a poor 
connection status allows data to be successfully transferred. Prior to installing the sensors 
and the ZL6, check the cellular connection at the location:

1. In ZENTRA Utility, click the Test button in the Button toolbar.

The Cellular Communication Test dialog will appear (Figure 7).

Figure 7 Cellular Communication Test dialog
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2. Click Test.

3. If the logger fails the test, move to a new location and try again.

Sometimes, moving just a few meters will provide a successful connection. 

NOTE: The ZL6 antenna is inside the enclosure. An antenna extension cable can also be used to elevate the 
antenna for increased signal strength. Contact Customer Support for more information.

4. Click Close.

2.2.3 INSTANTANEOUS SENSOR MEASUREMENTS SCAN
ZENTRA Utility will automatically scan the sensors attached to the ZL6 every 30 s and 
update the readings shown on the main screen (Section 4.2.3).

ZENTRA Utility can also take real-time sensor measurements on demand. This is a critical 
tool to ensure sensors are installed correctly, to test if a sensor is reading properly, or to 
evaluate how sensors react to environmental changes. The ZL6 does not store data that it 
measures with the scan function.

To force a new scan at any time, press the Scan button in the Button toolbar (Section 4.2.1). 
The sensor and measurement area will refresh.

2.2.4 DATA DOWNLOAD 
While at the installation site, allow the ZL6 to collect data for one or two measurement 
intervals, and download the collected sensor data to ensure the monitoring setup is working 
correctly. Periodically return to the site to download the stored data, to check the logger 
operation, and to retrieve stored data.

Download saved sensor and status data with ZENTRA Utility using the following steps: 

1. Connect the logger to a computer using the micro-USB cable.

2. Open ZENTRA Utility.

3. Choose the appropriate COM port from the dropdown list.

4. Click Connect.

5. Click Download on the Button toolbar. This will download the data stored since the last 
successful download.

Alternatively, go to the Data menu in the Menu bar and select either Download New 
(downloads the data stored since previous download) or Download All (downloads all the 
data currently stored in the ZL6).

6. Edit the File Name in the Save dialog. A suggestion will appear, based on the connected 
logger name and the time and date. 

7. Select the location on the computer where the file will be saved.

8. Click Save.
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ZENTRA Utility downloads sensor data and creates a Microsoft Excel® compatible file. 
The time-series sensor data saves to the Processed Records sheet of the workbook with 
metadata saved to the Metadata sheet. Metadata includes logger configuration settings, 
logger location, and sensor metadata, such as serial number and firmware version.

ZENTRA Utility will download data in the units chosen under Measurements in Manage 
Preferences dialog (Section 4.2.5). 

2.2.5 DATA DELETION
It is not necessary to delete data on the ZL6. Once all of the memory has been used, the 
ZL6 will start overwriting the data starting with the oldest records.

Erasing stored data is done with ZENTRA Utility. Before erasing data, download and save 
data onto a computer. 

CAUTION: This feature permanently erases all stored data on the ZL6. Data previously transmitted to ZENTRA Cloud 
are not erased. 

To erase data, follow the steps below:

1. In ZENTRA Utility click on the Data menu on the Menu bar.

2. Select Erase. A dialog will appear.

3. Click Erase Data to remove data or click Cancel to return to the main screen.

2.3 INTERFACING WITH ZL6 USING A SMARTPHONE OR TABLET
Download ZENTRA Utility Mobile from the app store before going to the field. Add ZENTRA 
Cloud user credentials to allow uploading data.

2.3.1 CONNECTION
The ZL6 shuts off the Bluetooth radio between connection sessions to save battery power. It 
is necessary to enable Bluetooth before trying to connect.

1. On the ZL6 press the TEST button to enable Bluetooth advertising.

2. On the mobile device launch ZENTRA Utility Mobile.

Look for the ZL6 in the Devices Found window (Figure 8).
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Figure 8 ZL6 in Devices Found window

3. Select the ZL6 to establish a connection. 

Once connected, ZENTRA Utility Mobile shows logger information and instantaneous 
sensor readings (Figure 9).

Figure 9 ZL6 information and current sensor readings

2.3.2 CONFIGURATION
The measurement interval and sensor types must be set before data will be correctly stored 
by the logger.
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1. On the ZL6, press the TEST button to enable Bluetooth advertising.

2. On the mobile device, open ZENTRA Utility Mobile.

3. Select the ZL6. 

4. Select Configure on the Actions panel (Figure 10).

Figure 10 Select Configure

The Configure Device screen will appear (Figure 11).

Figure 11 Configure Device screen
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5. Enter a device name (Figure 11). 

This value is prepopulated with the device serial number. Consider changing the name to 
the field or plot where the ZL6 is installed.

6. Enter a site name if desired.

7. In the Sensor Configuration panel verify the Measurement Interval is set to store data.

8. Verify each logger port is configured correctly for the installed sensor.

9. Click Save to send the updated parameters to the logger.

ZL6 Basic logger configuration is complete at this point. ZL6 and ZL6 Pro logger 
configuration will need to continue to step 10 through step 15 to set up the desired data 
upload times.

10. In the Communication Configuration panel, select Configure Cellular.

11. Select Upload Frequency to open the selection menu.

12. Choose upload fequency.

13. Select Done.

14. Select the time segments by clicking the arc segments for the hour intervals.

The ZL6 will upload data during the selected intervals (Section 4.2.5.1).

15. Click OK.

2.3.3 COMMUNICATION TEST (ZL6 AND ZL6 PRO)
A successful communication test will confirm that the ZL6 can transmit data to ZENTRA 
Cloud servers as well as provide the quality of the cellular connection. Even a poor 
connection status allows data to be successfully transferred. Prior to installing the sensors 
and the ZL6, check the cellular connection at the location:

1. Select the Cell Test button on the Actions panel (Figure 12).
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Figure 12 Select Test to begin Communication Test

2. Select Start test.

Figure 13 Select Start to begin the test
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If the logger fails the test, move to a new location and try again. Sometimes, moving just 
a few meters will provide a successful connection.

NOTE: The ZL6 antenna is inside the enclosure. An external antenna on an extension cable can also be used to 
for increased signal strength. Contact Customer Support for more information.

3. Click Close.

2.3.4 INSTANTANEOUS SENSOR MEASUREMENTS SCAN
ZENTRA Utility Mobile will automatically scan the sensors attached to the ZL6 every 30 s and 
update the sensor readings.

ZENTRA Utility Mobile can also take real-time sensor measurements on demand. This is a 
critical tool to ensure sensors are installed correctly, to test if a sensor is reading properly, or 
to evaluate how sensors react to environmental changes. The ZL6 does not store data that it 
measures with the scan function.

To force a new scan at any time, swipe down on the main screen. The sensor measurement 
area will refresh.
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3. SySTEM
This section reviews the ZL6 data logger hardware features and configuration options. Use 
this information to help optimize each environmental monitoring setup.

3.1 SPECIFICATIONS

MEASUREMENT SPECIFICATIONS
Sensor Logging Interval

ZL6 Basic 60 min (average or accumulation of 60, 1-min sensor readings)

ZL6 and ZL6 Pro 5 min to 12 h (average or accumulation of 1-min sensor reading)

Logger Reporting Interval

ZL6 Basic None

ZL6 Hourly with additional charges for more frequent reporting

ZL6 Pro Hourly with the ability to enable more frequent reporting

Timekeeping

ZL6 Basic Synchronize with ZENTRA Utility or ZENTRA Utility Mobile

ZL6 and ZL6 Pro
Synchronize automatically and on-demand;  
GPS, cellular, or ZENTRA Utility software

COMMUNICATION SPECIFICATIONS
Computer Communication

Standard USB cable, USB A to micro-USB B

Internet Downloads

SSL/TLS encrypted

Cellular Communication (ZL6 and ZL6 Pro)

3G 

Specifications UMTS 3G 5-band cellular module with 2G fallback

Coverage
550+ global partner carriers 
Cellular and data hosting service provided by METER
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4G LTE-M: USA, Canada, and slect other countries

(Contact Customer Support or a METER sales partner for more information).

Specifications 4G LTE-M and NB-IoT cellular

Coverage

VERIZON, AT&T®, and T-Mobile in the USA.

Select global partner carriers.

Cellular and data hosting service provided by METER.

Mobile Communication

Bluetooth 5.2 supporting Bluetooth Low Energy protocol

GPS Communication (ZL6 and ZL6 Pro)

Type Integrated 56-channel GPS/QZSS receiver

Update Daily (automatic) and on-demand (manual)

Accuracy ±3 m, with good sky view

PHySICAL SPECIFICATIONS
Dimensions

Length 14.9 cm (5.9 in)

Width 6.3 cm (2.5 in)

Height 25.0 cm (9.9 in)

Enclosure Material

Weather-, impact-, and UV-resistant polymer

Enclosure Rating

IP56, NEMA 3R

Enclosure Access

Hinged door with latches and eyelets for lock or zip tie

Sensor Input Ports

6 (supports METER analog, digital, or pulse sensors)

Sensor Port Type

3.5-mm stereo plug connector
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Memory Type

Nonvolatile flash, full data retention with loss of power

Data Storage

ZL6 Basic 2 MB (20,000 to 30,000 records depending on configuration) 

ZL6 and ZL6 Pro 8 MB (40,000 to 80,000+ records depending on configuration)

Battery Capacity

ZL6 Basic 6 AA alkaline batteries

ZL6 and ZL6 Pro 6 AA NiMH or alkaline batteries

Battery Life

Alkaline 3–12 months depending on configuration

NiMH
3+ years with unobstructed view of sun 
Charging through solar energy harvesting or USB

Operating Temperature Range

Minimum –40 °C

Maximum +60 °C

COMPLIANCE
Manufactured under ISO 9001:2015

EM ISO/IEC 17050:2010 (CE Mark)

3.2 HARDWARE COMPONENTS
The ZL6 data logger is housed in a weather-resistant enclosure (IP56 rated) (Figure 14). 
In extremely wet environments or environments with prolonged high humidity, enclose a 
desiccant packet inside the logger or enclose the logger in a waterproof case. The ZL6 and 
ZL6 Pro have an integrated solar panel to recharge NiMH batteries. 
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Figure 14  ZL6 data logger exterior

The ZL6 is purpose-built to collect data from environmental sensors sold by METER. The 
data logger has six ports for sensors and a micro-USB port for communicating with a 
computer (Figure 15). The data logger interior also contains a TEST button (Section 3.2.3) and 
two status lights, OK and ERROR (Section 3.2.4). The logger uses six batteries (Section 3.2.5). 
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TESTERROR
OK

(–)

(+)

(–)

(+)

(+)

(–)

(–)

(+)
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(+)
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(–)
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Figure 15 ZL6 data logger interior 

3.2.1 SENSOR INTERFACE
The ZL6 will detect the presence of METER sensors when connected to the sensor ports. For 
METER digital sensors, the ZL6 will detect and autopopulate the Sensor Type dropdown on 
the Manage Settings dialog in ZENTRA Utility (Section 4.2.5.1). For METER analog sensors, 
the ZL6 will show Unrecognized Sensor in the Sensor Type dropdown. Some sensors (such as 
pulse sensors) will not be detected by the ZL6. In these latter two cases the sensor will have 
to be manually selected from the dropdown menu.

NOTE: It is critical that the ZL6 is configured correctly for the attached sensors. Without correct configuration, the 
ZL6 will not record useful sensor information.

The ZL6 is able to detect when many of the METER sensors are unplugged or malfunctioning. 
The logger stores error codes in the place of normal sensor measurements in this event. 
ZENTRA software will display these errors to help troubleshoot problems with the sensors. 
The ZL6 cannot determine the difference between an intentionally uninstalled sensor and a 
malfunctioning sensor. Update the sensor configuration each time sensors are removed from 
or added to the ZL6.
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3.2.2 SENSOR MEASUREMENT INTERVAL
The measurement interval controls how often the ZL6 records sensor data to internal 
nonvolatile data storage. The interval applies to all ports on the ZL6 (i.e., the ZL6 cannot 
store data for one sensor at a faster rate than another sensor). This setting is controlled in 
the Sensor Configuration tab of the Manage Settings dialog (Section 4.2.5.1).

The measurement interval works relative to the ZL6 internal real-time, 24-h clock. For 
example, a measurement interval of 60 min results in the ZL6 storing data every hour, on the 
hour (e.g., 12:00 am, 1:00 am, ..., 10:00 pm). The ZL6 and ZL6 Pro minimum measurement 
interval is 5 min and the maximum measurement interval is 12 h. For most applications, 
a measurement interval of 60 min is appropriate. The ZL6 Basic measurement interval is 
60 min.

The ZL6 makes a measurement from each of the sensor ports in use every 60 s. When the 
ZL6 internal clock reaches the user-configured measurement interval, the ZL6 processes 
and stores the results from all the 60-s sensor readings taken since the last storage interval. 
For most sensors, the stored results are a simple average of the per-minute readings. For 
example, if the measurement interval for a TEROS 12 soil moisture sensor is 60 min, the 
ZL6 stores an average of the past 60 sensor readings. For a pulse-based sensor, such as 
a rain gauge, the ZL6 stores summed sensor readings. Some METER sensor user manuals 
contain more details of how the ZL6 processes sensor readings.

NOTE: Setting the ZL6 measurement interval to Off (not logging) turns off sensor measurement, data storage, and 
data uploads.

3.2.3 TEST BUTTON 
Pressing the TEST button initiates the self-test sequence. The self-test can take 60 s or more 
if testing communications over the cellular network. The following actions are part of the 
self-test sequence:
• Reboot the ZL6.

This ensures internal software restarts and operates in the expected way. Both status 
lights stay on during the reboot. This reboot will not erase data or reset settings.

• Perform basic functionality testing on internal systems and evaluates the amount of charge 
in the battery.

Both the green and red lights blink together slowly while the logger performs tests.

• Autodetect the connected sensors (Section 3.2.1).

• Start the embedded GPS receiver to obtain a current time and location fix (Section 3.2.6). 

This process takes as long as 15 min to complete.

• Establish an internet connection over the cellular network and attempt to communicate 
with ZENTRA Cloud.

• Enable the Bluetooth module to allow connection with ZENTRA Utility Mobile.
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After completing the self-tests, the ZL6 will indicate success or failure by lighting either the 
green or red status light. 

A solid green light (for approximately 20 s) indicates that internal tests passed and there is 
successful communication over the cellular network.

A solid red light indicates an error in the logger, which may indicate
• corrupt ZL6 logger firmware

• low batteries, or

• unsuccessful cellular communications (ZL6 and ZL6 Pro).

Use ZENTRA Utility to identify where the self-tests may have failed (Section 4.1) or consult 
troubleshooting to resolve logger errors (Section 5.2).

3.2.4 STATUS LIGHTS 
Lights near the TEST button indicate the status of the ZL6. A green light is labeled OK and a 
red light is labeled ERROR. There are several possible status states:
• The green light gives a short, single blink every 5 s to indicate the ZL6 is configured to log 

sensor data.

• The green light blinks slowly (1 s on, then 1 s off), to indicate the logger is communicating to 
a computer or using the cellular module.

• The green and red lights blink together during self-test procedures (after pressing the TEST 
button or pulling the battery tab). 

• The solid green or the red light at the end of the self-test sequence indicates the results of 
the tests.

• The lights remain off if the logger measurement interval is set to Off (not logging).

3.2.5 BATTERIES 
The ZL6 or ZL6 Pro is designed to use either AA NiMH rechargeable batteries or AA alkaline 
nonchargeable batteries. The logger autodetects the type of batteries installed and 
automatically adjusts the internal thresholds to represent 100% and 0% battery power. The 
ZL6 Basic is designed for AA alkaline batteries.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old alkaline batteries together.

Use NiMH batteries if the ZL6 or ZL6 Pro will be installed outdoors, where it can harvest 
solar energy to charge NiMH batteries. Orient the ZL6 enclosure to expose the solar panel 
to the maximum amount of sunlight available.  In the northern hemisphere, this typically 
means that the data logger will face south; in the southern hemisphere, this typically means 
that the data logger will face north. There may be local obstructions that make another 
orientation more favorable. The logger will charge the batteries even during periods of low 
light levels (e.g., winter time or heavy overcast conditions). For extended periods of low 
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light, the incoming energy may be lower than the energy needed to operate the logger. The 
batteries will buffer the energy needs of the logger for several months and will return to full 
capacity as the incoming energy exceeds the energy needed to operate the logger.

The ZL6 and ZL6 Pro will also harvest energy from the USB connection to a computer. 
Plugging the logger into a USB port for several hours will help restore NiMH batteries to full 
capacity.

Use alkaline batteries if the ZL6 or ZL6 Pro will be installed indoors or in a location where 
the harvested solar energy is not sufficient to keep the NiMH batteries charged. Alkaline 
batteries will last longer than NiMH batteries that are not being charged (6 to 7 months for 
typical configurations).

The ZL6 and ZL6 Pro are designed to prioritize sensor measurements over both the GPS 
and cellular communications features. If the battery level reaches a critical threshold 
(showing 0% in software), the logger will continue to make sensor measurements until the 
battery charge is too low to provide excitation power to the sensors. When new batteries are 
installed or recharged, the GPS receiver and cellular radio functionality will automatically 
start working again. 

Logged data are stored with nonvolatile flash memory and will not be lost if battery power 
fails. However, power must be restored to the logger to download data. 

3.2.6 GPS RECEIVER (ZL6 AND ZL6 PRO)
The ZL6 logger has a built-in GPS receiver that provides the latitude, longitude, and altitude 
of the logger. It is designed to provide time fix and location metadata for the environmental 
monitoring location. The ZL6 does not record the location of each individual sensor reading 
and is not optimized for applications such as geotagging a moving sensor platform.

The ZL6 enables the GPS receiver once per day. If the logger determines its location has not 
changed, it turns off the GPS receiver to save power. If the ZL6 detects a change, it keeps 
the GPS receiver powered for as long as 15 min to improve the accuracy of the location fix. 
Pressing the TEST button on the ZL6 triggers the logger to evaluate changes in location 
(Section 3.2.3).

3.2.7 TIMEKEEPING
The ZL6 keeps track of time using Universal Time Coordinated (UTC) seconds. All ZL6 models 
can  synchronize time using ZENTRA Utility and ZENTRA Utility Mobile. Additionally, the 
ZL6 and ZL6 Pro synchronize time using the GPS receiver or the cellular network. The 
ZL6 prioritizes using GPS time since this will be the most accurate; however, the logger will 
fall back to the other sources of time when the ZL6 does not have a good GPS time fix.

NOTE: The ZL6 Basic requires a time sync to accurately save a time and date stamp with each sensor measurement 
record. This time sync happens when the logger connects to ZENTRA Utility or ZENTRA Utility Mobile. The time must be 
reset any time the logger loses power (when batteries are removed or replaced).
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Data collected by the ZL6 uses the UTC time for the timestamp on each saved sensor record. 
ZENTRA Utility and ZENTRA Cloud display these data using local time based on where the 
logger is installed.

3.2.8 DATA STORAGE
The ZL6 only stores data for sensor ports that are configured for sensors (Section 3.2.1).  

The ZL6 Basic stores 2 MB of data and the ZL6 and the ZL6 Pro store 8 MB of data. When 
the logger has filled its memory, it begins overwriting the oldest data in the memory. Data 
storage capacity varies between approximately 6 months to several decades depending 
on the logger, connected sensors, and set measurement interval. ZENTRA Utility software 
displays how many days of data the ZL6 can hold based on the current measurement interval 
(Section 3.2.2), sensor configuration, and previously stored data.

The ZL6 data memory is nonvolatile flash. Removing the batteries or rebooting the logger 
(Section 3.2.3) will not erase stored sensor measurement data.

The ZL6 stores encoded data for each sensor to make data storage and transmitting 
convenient. ZENTRA software automatically decodes the sensor data to display them 
correctly.

3.2.9 CELLULAR COMMUNICATIONS (ZL6 AND ZL6 PRO)
The ZL6 has a built-in cellular module for uploading measurement data to ZENTRA Cloud. 
This allows for near real-time monitoring of the environment at the measurement site.

The ZL6 powers the cellular module only long enough to upload the data collected since the 
last time the logger successfully reported. During these upload times the ZL6 transfers data 
to ZENTRA Cloud, retrieves any pending settings changes, and occasionally performs system 
update to the logger. 

Upload session frequency and timing can be changed in ZENTRA Utility (Section 4.2.5.1) or 
ZENTRA Cloud. The default setting is for the ZL6 to upload data once per hour at a random 
time within each hour of the day at optimal hours. Less frequent uploads conserve battery 
power.

NOTE: Contact Customer Support if more frequent uploads are needed.

The ZL6 is available with either a 3G or 4G LTE-M cellular communication module. The 
ZL6 is configured to operate with more than and with 550 roaming partner networks 
in 190 countries. Please contact Customer Support or a METER sales partner for more 
information on the configuration that is best for the location where you plan to deploy
the instrument. 
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4. ZENTRA SOFTWARE
The ZL6 is designed to work with ZENTRA Utility Mobile, ZENTRA Utility, and ZENTRA Cloud. 
ZENTRA Utility Mobile communicates with the ZL6 using Bluetooth to configure the ZL6 and 
upload data to ZENTRA Cloud (Section 4.1). ZENTRA Utility communicates with the ZL6 via 
USB to configure the ZL6, download data to a computer, and upload these data to ZENTRA 
Cloud (Section 4.2). ZENTRA Cloud is a web-based application to remotely view and share 
environmental data, download spreadsheets, and configure the ZL6 (Section 4.3).

4.1 ZENTRA UTILITy MOBILE
ZENTRA Utility Mobile for iOS or Android Mobile Devices is a user-friendly interface for 
configuring and downloading data from the ZL6 logger that can be used on Apple (iPhone 
iOS 9.0 and newer) or Google (Android 4.3 and newer) smartphones or tablets. With ZENTRA 
Utility, the user can connect to ZL6 loggers directly to

• configure operation logger parameters,

• test ZL6 and ZL6 Pro cellular communications, and

• troubleshoot real-time sensor measurements (scan sensors).

ZENTRA Utility Mobile launches with an in-app tutorial to illustrate the important features 
of the app. Select More > In-App Tutorial to review this tutorial at any time. Use the Connect 
screen to select the ZL6 and use the ZENTRA Utility Mobile main screen to configure the 
logger and check sensor measurements.

Figure 16 ZENTRA Utility Mobile main screen
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4.2 ZENTRA UTILITy
ZENTRA Utility for Windows or Mac Computers is a user-friendly interface for configuring 
and downloading data from the ZL6 logger that can be used on any MacOS (10.9 and newer) 
or Microsoft Windows (7 and newer) laptop, netbook, or desktop computer. With ZENTRA 
Utility, the user can connect to ZL6 loggers directly to

• set all logger configuration parameters,

• test ZL6 and ZL6 Pro cellular communications,

• make real-time sensor measurements (scan sensors), 

• create Excel files with sensor data, and

• upload data to ZENTRA Cloud.

The ZENTRA Utility main screen should appear upon launch (Figure 17). Use the Menu bar 
and Button toolbar to interact with the ZL6.

Figure 17 ZENTRA Utility main screen

4.2.1 BUTTON TOOLBAR 
The Button toolbar provides shortcuts for the most frequent actions in using and configuring 
the ZL6 (Figure 17):
• COM port dropdown menu: Lists USB devices connected to the computer.

• Connect/Disconnect: Click the Connect button to attempt to connect to the device 
currently selected in the COM port dropdown menu. Click the Disconnect button to 
disconnect from the currently connected logger.

• Scan: Queries the connected ZL6 for the current sensor readings and updates the active 
sensors and measurements area.
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• Download: Downloads all data that has been collected on the ZL6 since the last time a 
download from the selected logger.

• Settings: Opens the Manage Settings dialog (Section 4.2.5.1).

• Test: Opens the Cellular Communication Test dialog (Section 2.2.2).

Figure 18 Button toolbar

4.2.2 DATA LOGGER IDENTIFICATION AREA
The Data Logger Identification area shows information for the connected ZL6. Hover over 
each item for its label. Any customizable fields can be adjusted through the Manage Settings 
dialog (Section 4.2.5.1).
• Serial Number: The factory-set unique serial number for each ZL6.

• Device Type: Model ZL6 or ZL6 Basic.

• Site Name: Customizable field to describe the ZL6 location.

• Remaining Battery Life: Icon that shows the battery charge remaining on the device.

• Cellular Strength: Icon that shows the strength of the cellular signal. This appears only 
after the cellular communication test is completed (Section 2.2.2).

• Device Name: Customizable field to describe the ZL6 device.

• Firmware Version: Version of firmware on the ZL6.

• Measurement Interval: Customizable field that describes the frequency at which the 
ZL6 will be recording measurements (Section 3.2.2).

• Time until Overwriting Data: Indicator of how much data are stored on the ZL6 and how 
long it will be able to record more measurements before overwriting older data.

4.2.3 ACTIVE SENSORS AND MEASUREMENTS AREA
All sensors plugged into the ZL6 are listed in this area and each sensor in this section is 
delimited by a horizontal bar (Figure 17). The left side of the section will have the sensor 
name and port number. The two on-board sensors (Battery and Barometer) will not show a 
port number. The right side of the section will list all measurements from the sensor, with 
a descriptor of the value. The measurements will use the units selected in the Manage 
Preferences Dialog (Section 4.2.5).

4.2.4 STATUS BAR
The Status bar in the bottom border of the screen will include what is happening in the 
software. It also shows the logger date and time. 
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4.2.5 MENU BAR
ZENTRA Utility Menu bar has six menus to access the program features: File, Data, Edit, 
Actions, Window, and Help. 

FILE MENU
The File menu includes two options:
• Disconnect: Disconnect from a logger and end communications.

• Quit: Closes ZENTRA Utility.

DATA MENU
The Data menu has three options:
• Download Data Since Last Download: Download the data stored since the last successful 

download.

• Download All Data: Download all the data currently stored in the ZL6.

• Erase: Deletes all stored data.

Section 2.2.4 provides instructions for downloading data from the ZL6 logger. 

The data downloaded by ZENTRA Utility will be calibrated correctly for each sensor type, 
except for soil moisture sensors. ZENTRA Utility uses a default calibration for soil moisture 
sensors that is appropriate for most mineral soils, but a custom calibration may be needed 
for the particular soil type. If a different soil moisture sensor calibration is necessary, change 
the Measurement Units to Raw VWC in the Manage Preferences tab. Raw VWC values will 
be downloaded in the Processed Data worksheet for use as inputs to custom calibration 
equations. See each specific sensor manual for alternative calibrations that can be applied 
to the raw data. 

EDIT MENU
The Edit Menu allows the user to edit preferences in the Manage Preferences dialog. These 
preference configurations will only be saved to the computer, not as measuring preferences 
in the ZL6 memory. It has four tabs for navigation:
• Measurements Tab (Figure 19):

 � Measurement Units: Set preferences for measurement units by using the dropdown 
menus. Click OK to apply the changes.
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Figure 19 Measurements tab

• Data File Tab (Figure 20):

 � Date and Time Display in ZENTRA Utility: Change the format of date and time values 
by selecting an option from the dropdown menus. This controls how date and time 
are shown in ZENTRA Utility display and in the downloaded files.

Figure 20 Data File tab
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• Application Tab (Figure 21):

 � Automatic Internet Version Check: Select the checkbox to automatically be notified 
when a new ZENTRA Utility version becomes available. Updates can be searched for 
manually at any time in the Help menu.

 � Automatic Clock Synchronization: Select the checkbox to keep the device clock 
synchronized with the connected computer clock. The date and time can also be 
updated by using the Actions menu.

If the computer will not always have the correct time zone setting for the logger 
sites, deselecting this option will not override the setting in the logger.

Figure 21 Application tab

• Communications Tab (Figure 22):

 � Device Commands Retries: Modifies the number of times ZENTRA Utility sends 
commands to a logger.

 � Extra Response Time: Modifies the length of time ZENTRA Utility waits for a 
response from the logger.

 � Communication Ports List: Enable this option if the USB device does not appear in 
the Connect dropdown list.

NOTE: Enabling this option may also find COM ports that are unavailable for use by ZENTRA Utility.

 � Power Noise Filter: Set the Power Frequency to eliminate electrical noise that 
comes from an AC power distribution system.

In North America and most of Asia, the frequency of the power cycle is 60 Hz (the 
default value); in most of Europe it is 50 Hz. This feature only needs to be set once, 
and the program will automatically update each connected device filter.
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Figure 22 Communications tab

ACTIONS MENU
The Actions menu is the primary menu for configuring and testing the ZL6 series logger.
• Select Sensors: Displays the Sensor Configuration tab in the Manage Settings dialog 

(Section 4.2.5.1).

• Set Device Time: Instructs ZENTRA Utility to set the ZL6 time and date according to the 
time and date on the computer.

• Digital Sensor Terminal: Sends commands through the ZL6 logger to a compatible METER 
digital sensor.

This feature can be used to troubleshoot the sensor by sending SDI-12 digital sensor 
communication commands. See respective sensor documentation for additional 
information on SDI-12 commands. 

• Test: Evaluates the ZL6 logger wireless signal (Section 2.2.2).

• Cellular Configure: Displays the Communication Settings tab in the Manage Settings dialog 
(Section 4.2.5.1).

• List Cellular Carriers: Queries the cellular module in the ZL6 logger for a list of carriers it 
detects. This is useful when trying to troubleshoot cellular connection problems. 

NOTE: The ZL6 may not be authorized to operate on any or all the carriers listed.

• Device Information: Displays the Device Information tab in the Manage Settings dialog 
(Section 4.2.5.1).

• Device Location: Displays the GPS Location tab in the Manage Settings dialog 
(Section 4.2.5.1). 
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• Show Raw Data/Show Processed Data: Toggle showing raw or processed data in the 
instantaneous measurements area of the main screen. Use the raw data display to help 
troubleshoot poor sensor measurements. 

WINDOW MENU
The Window menu provides the Show Terminal option. This allows for direct entry of 
commands to the ZL6 and is mainly used for troubleshooting.

HELP MENU
The Help menu has five options.
• Check for Software Updates: Checks for the newest available version of the ZENTRA Utility. 

If a newer version is available, a prompt will appear to install the update. The computer 
must be connected to the internet for this feature to work. ZENTRA Utility checks for 
newer versions of the program each time it launches. It will download these updates in the 
background automatically. 

• Check for Logger Firmware Updates: Checks for the newest version of ZL6 firmware 
from METER. If a newer version is available, ZENTRA Utility downloads the firmware in 
the background. 

When ZENTRA Utility connects to an ZL6, it compares the firmware on the logger with the 
latest version available. If the ZL6 firmware is out of date, ZENTRA Utility will prompt to 
start a firmware update for the logger. ZENTRA Utility maintains a cache of logger firmware 
to allow field firmware updates without a connection to the internet.

• Update Sensor Firmware: Some METER sensors (e.g., ATMOS and TEROS sensors) allow 
for firmware updates via ZENTRA Utility. Please consult the sensor user manual for 
more details. 

• Send Feedback to METER: Sends product feedback, bug reports, or feature requests to 
METER when connected to the internet (Figure 23). 
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Figure 23 Send Feedback to METER Group window

Enter name, company name, and contact information in the form. 

Identify the type of feedback being sent (general feedback, feature suggestions, bug report, 
or other).

Indicate if and how METER should respond (email or telephone).

Give details in the description area. If reporting a bug, detail what steps occurred prior to 
the bug and any error message. By default, bug reports include software error files. Other 
files can also be sent using this form (e.g., logger download files).

• About ZENTRA Utility: View the version of ZENTRA Utility currently installed. 

4.2.5.1 MANAGE SETTINGS DIALOG
Changing the ZL6 configuration happens in the Manage Settings dialog, which has four tabs. 
Use the following steps to access the Manage Settings dialog:

1. Click Settings on the Button toolbar (Section 4.2.1).

2. Make edits to the settings on the tabs. Refer to the details about the types of control 
settings in the following sections.

3. Click OK to save settings.

Click Cancel to exit without applying settings.
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DEVICE INFORMATION TAB
Use the Device Information tab to edit the information that appears in the Data Logger 
Identification area (Figure 24).
• Device Name: Logger-specific name to identify the logger in the software. The default name 

is the unit serial number. It can be changed to a name representing the field or plot where 
the logger is installed or the types of sensors installed.

• Site Name: Area-specific name to identify where a group of loggers are located in the 
software. The Site Name is optional. 

• Serial Number: Factory-set logger serial number that cannot be changed. 

• Time Zone: Time zone automatically set from ZENTRA Utility software or the cellular 
system.

• Firmware Version: Version of firmware on the ZL6. Check for the latest version of logger 
firmware, using the Help menu (Section 4.2.5).

• Device Type: Model of the ZENTRA logger connected to ZENTRA Utility (not editable). 

Figure 24 Manage Settings Device Information tab

SENSOR CONFIGURATION TAB
Use the Sensor Configuration tab to set the sensor measurement interval and to select 
sensors for each port (Figure 25).
• Measurement Interval: Controls how often the ZL6 stores sensor data (Section 3.2.2). The 

ZL6 Basic has only two options: 60 min and Off (not logging).

NOTE: Setting the measurement interval to Off (not logging) turns off sensor measurement, data storage, and 
data uploads.
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• Data Storage: Shows the percentage of logger storage currently used and an approximation 
of when the logger will begin overwriting the oldest data. This calculation is based on the 
data already stored, measurement interval, and existing sensor types configured in each 
port of the logger.

• Sensor port tabs: Displays sensor type and firmware version (when applicable) for each 
sensor port on the logger. Select the correct sensor type from the dropdown menu to 
ensure correct sensor measurements.

NOTE: Only digital sensors have firmware versions.

Figure 25 Manage Settings Sensor Configuration tab

COMMUNICATION SETTINGS TAB
Use the Communication Settings tab to control upload frequency and times for the 
ZL6 (Figure 26). This tab is unavailable for the ZL6 Basic.
• Upload frequency for each selected hour: Enable or disable automatic data uploads from 

the ZL6 to ZENTRA Cloud. The Upload Frequency describes how often data are uploaded 
and is a different setting than the sensor measurement interval. Data are sent once per 
hour. If more frequent uploads are needed, please contact Customer Support. METER offers 
cellular service plans that support uploading data every 15 min.

• Upload Times: Choose the approximate times of day that data are uploaded from the logger 
to ZENTRA Cloud. The data will be uploaded at a random time during each selected hour to 
upload data. To account for this variation, choose times prior to when the data are needed. 
By default, the ZL6 is configured to upload data at optimal hours to conserve battery. To 
conserve battery power further, choose fewer upload times.
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Figure 26 Manage Settings Communication Settings tab

GPS LOCATION TAB
The GPS location information in this tab is automatically provided by the GPS receiver 
built into the ZL6 and ZL6 Pro (Figure 27). The time zone is set by the computer or cellular 
network.
• Latitude and Longitude: Provides GPS location of the ZL6. 

• Altitude: Contains altitude from sea level of the ZL6.

• Time Zone: Offset from UTC time zone of the ZL6.
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Figure 27 Manage Settings GPS Location tab

4.3 ZENTRA CLOUD
ZENTRA Cloud is a cloud-based web application to download, view, and share ZL6 data as 
well as change logger configurations. ZENTRA Cloud is also designed to make it easy to 
share data with colleagues. A trial of ZENTRA Cloud is included with each ZL6 purchase. This 
manual offers only instructions to logging in to ZENTRA Cloud. Use the online help files to 
learn more about all the features of ZENTRA Cloud.

The first step to using the ZL6 with ZENTRA Cloud is to create a customer site (a group of 
users and loggers).

1. Navigate to the server listed on the orange subscription card (zentracloud.com or 
zentracloud.cn) (Figure 28).

  Device Subscription
Device Serial Number:  z6-00901z6-00901
Device Password:  passwordpassword
Server:  zentracloud.comzentracloud.com

Use this unique Device Serial Number and
Device Password to subscribe to this 
logger on zentracloud.com

      Keep this label in a safe place.
Do not leave it inside the device case.

Figure 28 Sample device subscription card

2. Click the Sign Up button.

http://www.zentracloud.com
http://zentracloud.cn
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3. Enter the required information, including a valid email address. 

4. Accept the terms and conditions.

5. Click Sign Up.

ZENTRA Cloud will send an email confirmation.

6. Click the link in the confirmation email inside email application.

7. Log in to ZENTRA Cloud.

To view data from ZL6 loggers on the customer site, subscribe to each desired ZL6 logger on 
ZENTRA Cloud following the steps below. A logger can only belong to one site at a time.

NOTE: Depending on the organization, labels may be Farm and Field or Site and Plot. These designations can be 
changed at any time. 

1. Select New Farm on the ZENTRA Cloud home screen.

2. Give the Farm a name.

A Farm can contain one or more Fields.

3. Select New Field.

4. Associate this Field to the Farm.

5. Give the Field a name. 

A Field can contain one or more loggers.

6. Select New Subscription.

7. Choose the Farm and Field.

8. Fill in the ZL6 Device Serial Number and Device Password as shown on the device 
subscription card (Figure 28).

Once subscribed to a ZL6, the logger should appear on the map and sensor data can be 
viewed and downloaded. Logger settings can be changed using ZENTRA Cloud. ZENTRA 
Cloud also provides a convenient way to share data from ZL6 loggers with colleagues, with 
user-set permissions. See the online help files for more information.
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5. SERVICE
This section describes the maintenance of the ZL6. Troubleshooting solutions and 
customer service information are also provided.

5.1 MAINTENANCE
The ZL6 may be returned to METER for maintenance (inspect system or replace old or 
damaged parts). Select replacement parts (e.g., USB cable, antenna, cable strain relief 
parts, or gaskets) can also be ordered from METER. Contact Customer Support for more 
information. ZENTRA Utility makes it easy to send feedback, bug reports, and feature 
requests to METER (Section 4.2.5).

The ZL6 requires little maintenance when installed correctly. Be sure to check ZL6 logger 
periodically:
• Replace batteries as needed.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old batteries together.

• Inspect the battery holders to ensure they are clean and free of corrosion.

• Verify that the sensor ports are clean and that the sensors are making good contact with 
the ports.

• Clean the inside of the sensor ports with isopropyl alcohol and a swab if soil or other 
foreign materials are visible.

• Check case gaskets and strain relief hooks. Replace gaskets every 1 to 2 years, as needed.

• Replace zip ties securing the logger annually or as needed.

NOTE: Never immerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, or improper 
installation may damage the ZL6 and void the manufacturer’s warranty.

NiMH batteries should last for several years if they are charging properly. Over a long period 
of time, NiMH batteries will begin to lose their charge capacity. If dark periods lasting 
months cause the batteries to discharge too low, it is time to replace the NiMH batteries. 
When replacing NiMH batteries, use high-quality batteries advertising higher charge 
capacity. New NiMH batteries may also be purchased from METER. Contact Customer 
Support to discuss concerns or recommendations. 

Alkaline batteries should be replaced when the battery charge nears 0%. Replace batteries 
with high-quality alkaline batteries. A low-quality battery may not provide the desired 
battery life for the ZL6 logger.

NOTE: Installing or replacing the batteries in the ZL6 resets the internal real-time clock. The ZL6 requires a time sync 
to accurately save a time and date stamp with each sensor measurement record. The ZL6 and ZL6 Pro time can be 
set from ZENTRA Utility, the on-board GPS receiver, or the cellular network. Press the TEST button after changing the 
batteries to enable the GPS receiver to acquire a new time and position fix. The ZL6 Basic receives a time sync when 
the logger connects to ZENTRA Utility or ZENTRA Utility Mobile.
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5.2 TROUBLESHOOTING
Although the ZL6 is designed for durability and built to the highest manufacturing standards, 
problems may occasionally occur. This troubleshooting section details the major problems 
and their solutions. If the problem is not listed or these solutions do not solve the issue, 
contact Customer Support.

Table 3 Troubleshooting the ZL6

Problem Possible Solutions

ZENTRA Utility cannot 
connect to the device

or

ZL6 logger not showing in 
the COM port picker

If using a Windows computer, reinstall the USB driver from metergroup.
com/zl6-support. 

Mac computers running ZENTRA Utility do not require a custom USB 
driver.

Check that the USB cable is securely plugged into the logger and the 
computer.

Ensure the logger has good batteries. 

Press the TEST button on the logger to reset it.

Connect to a second logger. If the connection works, the problem is likely 
with the first logger. 

Try a different micro-USB cable. Ensure the cable is not intended for 
charging only.

ZENTRA Utility reports it 
lost the connection

Check or replace the USB cable.

Increase the number of times ZENTRA Utility tries sending commands to 
the logger:
• Go to the Manage Preferences menu.
• Select the Communication tab.
• Increase the Direct Connect Retries.

ZENTRA Utility states 
there is no new data for 
downloading

or

Logger stopped making 
measurements

Wait for at least the length of the measurement interval to ensure the 
logger had enough time to record data.

Ensure the logger is configured to measure data, i.e., make sure the 
measurement interval is not set to Off (not logging).

Check the battery. The ZL6 will stop making sensor measurements when 
the batteries are extremely low.

Press the TEST button to reset the logger.

Sensor measurement 
data does not seem to 
be correct

Switch the sensor to a known working port and scan again. If the 
problem follows the sensor, then the sensor may be damaged.

Many issues affect the quality of the sensor measurement. Please see 
the sensor user manual for troubleshooting.

http://www.metergroup.com/ZL6-support
http://www.metergroup.com/ZL6-support
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Table 4 Troubleshooting the ZL6 (continued)

Problem Possible Solutions

Sensor data shows No 
response from sensor in 
the Scan window 

or

Downloaded data shows 
#N/A

The raw data measured by the logger is out of expected range for the 
sensor. This could be caused by an unplugged or broken sensor.

Ensure the sensor stereo plug is fully inserted into the logger 
sensor port.

Ensure the sensor type shown in the Scan window matches the sensor 
connected to the logger.

Switch the sensor to a known working port and scan again. If the sensor 
shows data, the port may be damaged. If the No response from sensor 
message is still presenting, the sensor could be unplugged or broken. 

If the problem persists, contact Customer Support.

Red ERROR light and/
or green OK light are 
always on

Check logger batteries.

Press the TEST button to reset the ZL6.

If the problem persists, contact Customer Support.

Red ERROR light is on 
after pressing the TEST 
button

See Section 3.2.3 for information on the TEST button results and how 
to further troubleshoot.

Cellular uploads stopped 
working

Press the TEST button to reset the ZL6.

Run the Cellular Communication Test in ZENTRA Utility to determine if 
there is a communication error.

Check the List Cellular Carriers function in ZENTRA Utility to confirm 
there are cellular carriers operating in the area.

If the problem persists, contact Customer Support.

Logger does not seem 
to be working correctly 
or reliably

Press the TEST button on the logger to reset the ZL6.

Check logger batteries. Replace alkaline batteries if close to 0%. 
Recharge NiMH batteries if close to 0%.

Check for corrosion or water damage. Check that the seals and 
gaskets are intact.

If the problem persists, contact Customer Support.

Water is found inside 
the logger

Precipitation can be trapped between the solar panel cover and the 
top of the door in windy conditions and drip into the logger. Wipe off 
the logger interior and the top of the door.

If this problem recurs frequently, consider enclosing the logger in a 
waterproof case.
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5.3 CUSTOMER SUPPORT
NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 7:00 am to 5:00 pm Pacific time. 

Email: support.environment@metergroup.com 
sales.environment@metergroup.com

Phone: +1.509.332.5600

Fax: +1.509.332.5158

Website: metergroup.com

EUROPE
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 8:00 to 17:00 Central European time. 

Email: support.europe@metergroup.com 
sales.europe@metergroup.com

Phone: +49 89 12 66 52 47

Fax: +49 89 12 66 52 20

Website: metergroup.de

If contacting METER by email, please include the following information: 

Name 
Address 
Phone

Email address 
Instrument serial number
Description of the problem

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

5.4 TERMS AND CONDITIONS
By using METER instruments and documentation, you agree to abide by the METER Group, 
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.

mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com
mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com/de
http://www.metergroup.com/terms-conditions
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APPENDIX A. COMPLIANCE CERTIFICATIONS
This appendix contains compliance statements that apply to the ZL6.

A.1 USA
This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause 
undesired operation.

The ZL6 series loggers contain one or more of the following radio modules, listed by their FCC 
identification numbers:

• SH6MDBT40 (all ZL6 series)

• XPY2AGQN4NNN

• XPYLISAU201 or XPYLISAU200

Changes or modifications to the ZL6 series loggers or antenna not expressly approved by 
METER Group, Inc. USA could void FCC compliance and thus the user’s authority to operate the 
equipment.

A.2 CANADA
Industry Canada (IC) Notices

This Class B digital apparatus complies with Canadian CAN ICES-3(B) / NMB-3(B) and RSS-210. 
Operation is subject to the following two conditions:

• this device may not cause interference

• this device must accept any interference, including interference that may cause undesired 
operation of the device

The ZL6 series loggers contain one or more of the following radio modules, listed by their IC 
identification numbers:

• 8017A-MDBT40 (all ZL6 series)

• 8595A-LISAU201 or 8595A-LISAU200N

• 8595A-2AGQN4NNN

Radio Frequency (RF) Exposure Information
This device has been evaluated and shown compliant with the IC RF Exposure limits under 
mobile exposure conditions (antennas are greater than 20cm from a person’s body).

Avis d’Industrie Canada (IC)
Cet appareil numérique de classe B est conforme aux normes canadiennes CAN ICES-3(B) / 
NMB- 3(B) et RSS-210.
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Son fonctionnement est soumis aux deux conditions suivantes:

• cet appareil ne doit pas causer d’interférence

• cet appareil doit accepter toute interférence, notamment les interférences qui peuvent 
affecter son fonctionnement

Informations concernant l’exposition aux fréquences radio (RF)
Ce périphérique a été évalué et démontré conforme aux limites d’exposition aux fréquences 
radio (RF) d’IC lorsqu’il est installé dans des produits hôtes particuliers qui fonctionnent 
dans des conditions d’exposition à des appareils mobiles (les antennes se situent à plus de 
20 centimètres du corps d’une personne).

Changes or modifications to the ZL6 series loggers not expressly approved by METER Group, 
Inc. USA could void Industry Canada (IC) compliance and thus the user’s authority to operate 
the equipment.

A.3 EUROPEAN UNION
R&TTED and European Conformance CE mark

Radiofrequency radiation exposure Information: this equipment complies with radiation 
exposure limits prescribed for an uncontrolled environment for fixed and mobile use conditions. 
This equipment should be installed and operated with a minimum distance of 20 cm between 
the radiator and the body of the user or nearby persons. This transmitter must not be co-located 
or operating in conjunction with any other antenna or transmitter except as authorized in the 
certification of the product.

A full CE declaration of conformity for the ZL6 is available on request from METER Group.

A.4 JAPAN
TELEC (Japan)

The ZL6 series loggers contain one or more of the following radio modules that are TELEC/
JATE certified.

All ZL6 series:

• Technical Requirements certified type number: 201-160496

ZL6 with TELEC-approved cellular module:

• Technical Conditions certified type number: AD120274003 

• Technical Requirements certified type number: 003-120375



ZL6

INDEX
B

battery
charging  1, 22
diagram  20
installation  2, 22–23, 23
life  18, 27
replacement  23, 39
types  22

C

cellular communication test  8, 13–14
cellular module  16, 24
communication settings  35–36
compliance

CE  18, 44
IC  43
ISO 9001:2015  18
TELEC  44

components
antenna  9
batteries  22–23
enclosure  19–20
GPS module  23
included  1
memory  24
reference barometer  1
status light  19, 22
TEST button  19, 21–22

configuration  4–10
computer communication  3
sensor  6–10
using ZENTRA Utility  3, 4–10
using ZENTRA Utility Mobile  10–11

D

data collection
encryption  16

metadata  10
sensor calibration  28
storage  18, 24, 35
timekeeping  23
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